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1 Printer Overview
This printer lets you print, copy, and scan pictures and documents. In addition, this 
printer supports networking, letting you access the printer over a wireless (Wi-Fi) 
network.

Components

1 Left paper-edge guide* 9 Memory card slot

2 Paper guard 10 Access door

3 Paper input tray 11 Printhead with ink cartridges installed

4 Scanner glass 12 USB port

5 Scanner lid 13 Power cord port

6 Control panel 14 Paper output tray extender

7 Power button 15 Paper output tray

8 Wi-Fi connectivity LED

*Right paper-edge guide not shown. When you move one guide, both guides move.
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Printer Overview
Control panel 

Feature Description

1 LCD Displays pictures, messages, and menus

2 Navigation buttons Used to navigate menus and scroll through pictures

3 OK button Selects a menu item and allows you to continue with the 
current operation

4 Start button Begins copying, scanning, printing, maintenance tasks, and 
file transfer

5 Cancel button Stops the current operation and returns to the previous menu

6 Back button Displays the previous screen or the next highest screen in the 
menu

7 Home button Displays the main menu
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KODAK ESP 1.2 All-in-One Printer
Home Center Software 
KODAK Home Center Software is installed with your KODAK All-in-One Printer 
Software, unless you choose otherwise. The Home Center icon will appear on your 
desktop (WINDOWS OS) or dock (MAC OS). 

NOTE: You can choose to install the KODAK AiO Printer Software Essentials, which 
includes the printer drivers and Printer Tools (WINDOWS OS only). 

On a computer with WINDOWS Operating System (OS), you can use Home Center 
Software to:

• browse, crop, enhance, and edit pictures

• print and scan

• make 3D pictures (from picture pairs taken to create 3D pictures)

• print from video

• send images to or print images from KODAK Gallery

• send images to or print images from FACEBOOK Social Network, FLICKR, 
PHOTOBUCKET, PICASA Photo Management Systems, and GOOGLE DOCS 
Program

• configure your printer

• install new network printers

• upgrade to the latest printer software and firmware

• order supplies

• access the KODAK Tips and Projects Center

• see the status of your printer

• set up Google Cloud Print™ and KODAK Email Print Service

• access the KODAK Online Printer Management Tool

On a computer with MAC OS, you can use Home Center Software to: 

• scan

• configure your printer

• upgrade to the latest printer software and firmware

• order supplies

• see the status of your printer

• set up Google Cloud Print and KODAK Email Print Service

• access the KODAK Online Printer Management Tool
www.kodak.com/go/aiosupport 3



Printer Overview
Ordering supplies
You can order ink cartridges, paper, and accessories online. An Internet connection 
is required.

To order supplies directly from Home Center Software:

1. Open Home Center Software.

2. Select Order Supplies (on a computer with WINDOWS OS) or select the Tools 
tab, then click Order Supplies (on a computer with MAC OS). 

3. Select the item(s) you want to buy, then follow the on-screen instructions. 

To order supplies from the Web: 

• Ink: www.kodak.com/go/printingsupplies

• Paper: www.kodak.com/go/inkjetpaper
4 www.kodak.com/go/aiosupport
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KODAK ESP 1.2 All-in-One Printer
Configuring printer settings
To set or change basic printer settings: 

1. Press .

2. Press  to select Printer Settings, then press OK.

3. Press  to select one of the following settings: 

• Date and Time
– Press OK, then press  to select Year, Month, Day, Hour, or Minute.

– Press  or  to change the values; press OK when you are done making 
changes. 

– Press  to return to the Printer Settings menu.

• Button Sounds

– Press  or  to toggle the button sounds On or Off. Press OK to save 
your selection.

• Time to Low Power 

To conserve energy, your printer will enter a low power (sleep) mode after 
being idle for a default delay time of 1 hour. You can increase the delay time to 
low power. Increasing the delay time may result in reduced energy savings.

– Press  to change the time to energy-saving sleep mode (select from 1 to 
4 hours in 0.5 hour increments). After the time to low power, the printer 
enters a low-power (sleep) mode. 

• Tagged Images Printing (see Printing tagged pictures, page 34)

– Press  to select Off or On.

• Language
– Press OK, press  to select a language, then press OK.

• Country/Region
– Press OK, press  to select a country or region, then press OK.

• Reset All Settings (see Resetting factory defaults, page 74)

NOTE: Resetting factory defaults does not change the date and time, 
language, country/region, or network settings.

• Printer Info
– Press OK to view the Firmware Version number; press OK when you are 

done.

4. Press  to return to the Main Menu.
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2 Networking Your Printer
This section explains how to configure your wireless network settings.

Connecting to a wireless network
To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the 
following information. 

Before you connect

You need:

• a wireless router.

• to determine whether your wireless router supports Wi-Fi Protected Setup 
(WPS).

NOTE: If you have specific questions about your router, see your router 
manufacturer’s documentation for more information.
6 www.kodak.com/go/aiosupport



KODAK ESP 1.2 All-in-One Printer
Connecting to a wireless network using the Wi-Fi Setup Wizard

You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless 
network. Use the procedure that is appropriate for your network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network 
name, also called the Service Set Identifier (SSID). You can obtain your network 
name from the wireless router. See the manufacturer’s documentation for more 
information.

If you have enabled security on your network, you also need to know the security 
string, which may be a Wired Equivalent Privacy (WEP) or a Wi-Fi Protected Access 
(WPA/WPA2) passphrase.

Record your network information using the correct uppercase and lowercase letters.

Network Name (SSID):______________________________________________________

Security String (case-sensitive):______________________________________________

1. Press .

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup 
Wizard.

The Wi-Fi connectivity LED blinks as the printer searches for available wireless 
networks within range, then displays the list in order of signal strength. For 
example:

If there are additional networks than can be shown on the LCD, a  (page 
down) symbol appears in the bottom right of the display. 
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Networking Your Printer
4. If the name of your network is:

5. If your network has security enabled, use the LCD keyboard (see Using the LCD 
keyboard, page 10) to enter your security string.

6. When the confirmation message appears, press OK. 

When the printer is successfully connected, the Wi-Fi connectivity LED stops 
blinking and remains lit. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESP1.2+1133).

7. If you haven’t installed the KODAK All-in-One Printer Software:

a. Go to www.kodak.com/go/aiodownloads.

b. In the search results, click the link for KODAK All-in-One Printer Software for 
your computer operating system.

c. Follow the on-screen instructions.

Listed Not listed

Press  to select your 
network, then press OK.

Make sure your wireless router is turned on and 
within range. If your wireless router does not 
broadcast its SSID (network name): 

1. Press  to select Unlisted Network, then press 
OK. 

2. Use the LCD keyboard (see Using the LCD 
keyboard, page 10) to enter your network name.

3. Select WEP or WPA/WPA2 as required for your 
network's security setup, then press OK.

NOTE: If the name of your network is still not listed, 
or you want to change your network, press  
to select Rescan for Wireless Networks, 
then press OK.
8 www.kodak.com/go/aiosupport
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KODAK ESP 1.2 All-in-One Printer
Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. 
WPS lets you configure your printer for a wireless network by pressing buttons or 
entering a PIN.

To connect to a network using WPS:

1. Press .

2. Press  to select Network Settings, then press OK.

3. With Wi-Fi Setup Wizard selected, press OK.

NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup 
Wizard.

4. With WPS Connect selected, press OK.

5. Select one of two methods of connecting: 

IMPORTANT: Before you press OK on the printer, make sure you know where the 
router's push button is, or where to enter the generated PIN. If 
necessary, consult your Internet service provider or router device 
manufacturer’s documentation for more information.

6. When the confirmation message appears, press OK.

When the printer is successfully connected, the Wi-Fi LED will stop blinking and 
remain lit.

7. If you haven’t installed the KODAK All-in-One Printer Software: 

a. Go to www.kodak.com/go/aiodownloads. 

b. In the search results, click the link for KODAK All-in-One Printer Software for 
your operating system.

c. Follow the on-screen instructions. 

Push Button Configuration Generate WPS PIN

NOTE: You will have two minutes to 
press or select the WPS button. 
It may be a button on the device 
or a virtual button in the device’s 
software.

a. With Push Button Configuration 
selected, press OK. 

b. Press or select the WPS button for 
your wireless router.

a. Press  to select Generate 
WPS PIN, then press OK.

b. In your wireless router’s software, 
locate the PIN screen.

c. Enter the PIN you received on the 
LCD into the PIN screen, then 
follow the router’s instructions. 
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Networking Your Printer
Using the LCD keyboard

When you need to enter letters or numbers, a keyboard appears on the LCD.

Setting up an IP Address
IMPORTANT: You should only need to set up an IP Address for your printer if you are 

having a problem with connecting to your network. Typically, it is not 
necessary to set up an IP Address. This procedure is for advanced users who 
know how to obtain the IP Address for the printer.

To set up your IP Address on the printer:

1. Press .

2. Press  to select Network Settings, then press OK.

3. Press  to select Advanced IP Address Setup, then press OK.

4. Press OK again to continue.

5. Select one of the following, then press OK:

• Dynamic (DHCP) 

• Manual (Static)
6. If you selected Manual (Static), you are prompted to enter an IP Address, a 

Subnet Mask, a Gateway Address, and a DNS Server address. Press OK after 
each entry. Use the navigation buttons to enter each digit.

Consult your Internet service provider or network administrator for more 
information.

On the control panel, press , , or  to select the 
letters and numbers, using the correct uppercase and 
lowercase letters. Press OK after each character. When you 
are done, select DONE, then press OK.
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KODAK ESP 1.2 All-in-One Printer
Viewing the network configuration

To view the network configuration and verify that you are connected to your wireless 
network:

1. Press .

2. Press  to select Network Settings, then press OK.

3. Press  to select View Network Configuration, then press OK.

The Wi-Fi Network Settings appear on the LCD, including:

• Connection

• IP Address

• Printer Name

• Printer Hostname

• Connected Network SSID

• Speed 

• IP Address Type

• Network Subnet

• Security

• Authentication

• Channel

• Region

• Radio (on/off)

• MAC Address

If the printer is connected to your network, you will see the network name and 
the word CONNECTED. 

4. To scroll through the information, press . 

5. When you are done, press OK.

Printing the network configuration
To print the current network configuration:

1. Load plain paper into the printer. (See Loading plain paper, page 20.)

2. Press .

3. Press  to select Network Settings, then press OK.

4. Press  to select Print Network Configuration, then press OK.
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Networking Your Printer
Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK 
All-in-One Printer Software on each computer.

1. Go to www.kodak.com/go/aiodownloads. 

2. In the search results, click the link for your operating system.

3. Follow the on-screen instructions. 

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have a HERO 3.1 
Printer and now you are adding an ESP 1.2 Printer), you must install the software for 
the newer model. 

NOTE: When you install the new software, the printer driver for the HERO 3.1 
Printer will be uninstalled, and an upgraded driver for the HERO 3.1 Printer 
will be installed in addition to the driver for the ESP 1.2 Printer. 

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Setup Utility.

• If your wireless printer (example: KodakESP1.2+0034) is not listed: 

a. Select No, my printer is not listed, then click Next.

b. From the drop-down list, select your printer, then click Next.

c. Select Network - Wireless/Wi-Fi, then click Next.
When your printer is detected, driver installation begins.

• If your wireless printer (example: KodakESP1.2+0034) is listed:

a. Select the printer that is connected to your network, then click Next.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

2. When driver installation is complete, click Done. 

On a computer with MAC OS:

1. Select Apple > System Preferences.

2. Under Hardware, select Print & Fax or Print & Scan.

3. Click + in the dialog box.

4. Select your printer from the list.

5. Click Add, if required.
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KODAK ESP 1.2 All-in-One Printer
Adding a wireless network connection to a USB-connected computer
You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

To change the printer connection type from USB to a wireless (Wi-Fi) network:

If your printer is connected to a computer with WINDOWS OS:

1. Disconnect the USB cable from your printer and computer.

2. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 6.

3. On your computer, disable any firewall you have installed until you have 
successfully connected your printer.

4. Select Start > All Programs > Kodak > Kodak Printer Setup Utility.

• If your wireless printer (example: KodakESP1.2+0034) is not listed:

a. Select No, my printer is not listed, then click Next.

b. Select your printer from the list, then click Next.

c. Select Network - Wireless/Wi-Fi, then click Next. 
When your printer is detected, driver installation begins.

• If your wireless printer (example: KodakESP1.2+0034) is listed: 

a. Select the printer that is connected to your network, then click Next.

b. Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

5. When driver installation is complete, click Done. 

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESP1.2+0034).

If your printer is connected to a computer with MAC OS:

1. Disconnect the USB cable from your printer and computer.

2. If you have not already done so, connect your printer to your wireless network. 
See Connecting to a wireless network, page 6.

3. Select Apple > System Preferences.

4. Under Hardware, select Print & Fax or Print & Scan.

5. Click + in the dialog box.

6. Select your printer from the list.

7. Click Add, if required.

The printer with a wireless connection is listed as the name of the printer plus a 
number (for example, KodakESP1.2+0034).
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3 Online Printer Management Tool
The Online Printer Management Tool lets you access your printer through an 
Internet browser (such as INTERNET EXPLORER, FIREFOX, SAFARI, or CHROME) on 
any computer that is on the same network as your printer. 

IMPORTANT: Your computer and your printer must be on the same wireless network. The 
Online Printer Management Tool is not available if your printer is connected 
to a computer with a USB cable. 

With the Online Printer Management Tool, you can:

• view printer status

• set up accounts for Google Cloud Print™ and KODAK Email Print Service
14 www.kodak.com/go/aiosupport



KODAK ESP 1.2 All-in-One Printer
Accessing the Online Printer Management Tool
Access the Online Printer Management Tool in one of the ways described below. 

Directly from Home Center Software v7.x or higher:

1. Open Home Center Software.

2. Select Printer Tools on a computer with WINDOWS OS, or Tools on a computer 
with MAC OS.

3. Make sure that the name of your wirelessly connected printer appears in the 
bottom of the window (WINDOWS OS only).

NOTE: A printer with a wireless connection is listed as the name of the printer plus 
a number (for example, KodakESP1.2+1133). If a different printer name 
appears, click Select, then choose your wirelessly connected printer.

4. Under Tools, select Online Printer Management.

The Online Printer Management Tool opens.

On any printer-supported computer: 

1. Get the IP Address of your wirelessly connected printer:

a. On your printer control panel, press .

b. Press  to select Network Settings, then press OK.

c. Press  to select View Network Configuration, then press OK.

NOTE: If you prefer a printout, press  to select Print Network Configuration, then 
press OK. A Network Configuration Page prints, including the IP Address in 
the format xxx.xxx.xxx.xxx. 

d. Press  to see the IP Address in the format xxx.xxx.xxx.xxx. (See Viewing the 
network configuration, page 11). 

2. On your computer, open your preferred Internet browser (such as, INTERNET 
EXPLORER, FIREFOX, SAFARI, CHROME).

3. Type the printer IP Address in the browser address (URL) bar, then press Enter.

The Online Printer Management Tool opens.
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Online Printer Management Tool
Setting up Cloud Printing

Registering your printer with Google Cloud Print™

Your printer lets you print from anywhere in the world from your smartphone, tablet, 
or computer that uses Google Cloud Print enabled apps. You must register your 
printer with a GOOGLE Account to enable this feature.

1. Make sure your printer and computer are connected to the same network (see 
Networking Your Printer, page 6). 

2. Make sure you have the latest version of Home Center Software and printer 
firmware (see Updating the software and printer firmware, page 73). 

3. Do one of the following:

NOTE: After you select Cloud Printing Setup, the Online Printer Management Tool 
opens in your Web browser.

• Open Home Center Software, then click Cloud Printing Setup.

• Depending on your Operating System, use the path below to select Cloud 
Printing Setup.

– WINDOWS XP OS: Select Start > Programs > Kodak > KODAK AiO Printer 
Tools, then click Cloud Printing Setup.

– WINDOWS VISTA and 7 OS: Select WINDOWS icon > All Programs > 
Kodak > KODAK AiO Home Center > Printer Tools, then click Cloud Printing 
Setup.

– MAC OS: Select KODAK AiO Home Center > Tools, then click Cloud 
Printing Setup.

4. Follow the on-screen instructions. 

5. In the GOOGLE Window, click Finish printer registration.

6. Return to the Online Printer Management Tool. 

7. Wait until you see Registration Successful for Google Cloud Print. This may take 
a few minutes.

8. To register your printer with KODAK Email Print Service, and get an email 
address for your printer, click Get Printer Email Address for KODAK Printer, then 
go to step 3 of Registering your printer with KODAK Email Print Service, page 17. 

9. Sign out of your GOOGLE Account and close the Online Printer Management 
Tool.

For information about printing, see Printing using Google Cloud Print, page 37.
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KODAK ESP 1.2 All-in-One Printer
Editing a Google Cloud Print™ Account

Once you have successfully registered your printer with Google, you can make edits 
to various fields.

1. Open the Online Printer Management Tool (see Accessing the Online Printer 
Management Tool, page 15).

2. Select the Settings tab. 

3. Select Cloud Printing > Google Cloud Print.

4. Click Edit Settings.

5. Make the changes you want in the appropriate fields, then click Save.

Registering your printer with KODAK Email Print Service

KODAK Email Print lets you send emails and email attachments to your printer using 
any email account. Your printer must be registered to Google Cloud Print before you 
can register to KODAK Email Print (see Registering your printer with Google Cloud 
Print™, page 16).

1. Go to www.kodakeprint.com.

2. Sign in with the account you used to set up Google Cloud Print (see Setting up 
Cloud Printing, page 16).

3. Click Enable next to your printer.

4. Make sure you have letter or A4 size paper loaded in the printer. 

A page will be sent to your printer to indicate your printer has been successfully 
set up. (This may take a few minutes.) The page includes the email address of 
your printer.

5. To limit who can send emails to your KODAK Printer email address: 

a. Next to Access Control, click Edit.

b. Select Control who can send email (by email or domain). 

c. To add a specific email address, click Add new Email/Domain. 

d. Type the email or domain information, then click Save.

NOTE: To delete an email or domain, click Delete.

For information about printing, see Printing using KODAK Email Print Service, 
page 38.
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4 Handling Paper
For the best document printing results, use KODAK Document Papers or a paper 
with the COLORLOK Technology logo on the package. Use only paper that is 
designed for inkjet printers.

For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with KODAK All-in-One Printers, or photo papers designed for use on 
pigment-based inkjet printers.

When handling photo paper:

• Hold the paper by the edge to avoid transferring fingerprints.

• Do not touch the glossy side of photo paper.

• Store paper flat, away from direct sunlight and heat.

Paper types
You can use: 

• Plain paper — 16 to 24 lb / 60 to 90 gsm

• Photo paper — up to 12 mils 

• Card stock — 110 lb / 200 gsm, max

• Envelopes — most standard types

• Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets

• Iron-on transfers — all commercially available inkjet varieties on 8.5 x 11-in. or 
A4 sheets
18 www.kodak.com/go/aiosupport



KODAK ESP 1.2 All-in-One Printer
Paper sizes
The printer accepts the following paper sizes: 

• 4 x 6 in. / 10 x 15 cm

• 4 x 7 in. / 10 x 18 cm

• 4 x 8 in. / 10 x 20 cm

• 4 x 12 in. / 10 x 31 cm

• 5 x 7 in. / 13 x 18 cm

• 7.3 x 8.5 in. / 18 x 22 cm 

• US Executive (7.3 x 10.5 in. / 18 x 27 cm) 

• 8 x 10 in. / 20 x 25 cm

• US Letter (8.5 x 11 in. / 22 x 28 cm)

• Legal (8.5 x 14 in. / 22 x 36 cm)

• A4 (8.3 x 11.7 in. / 21 x 30 cm) 

• A5 (5.8 x 8.3 in. / 15 x 21 cm)

• A6 (4.1 x 5.8 in. / 11 x 15 cm)

• B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.
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Handling Paper
Envelope sizes
The printer accepts the following envelope sizes: 

• C5 (6.7 x 9 in. / 16 x 23 cm)

• C6 (4.5 x 6.4 in. / 11 x 16 cm)

• DL (4.3 x 8.7 in. / 11 x 22 cm)

• US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

• US #9 (3.9 x 8.9 in. / 10 x 23 cm)

• US #10 (4.1 x 9.5 in. / 11 x 24 cm)

IMPORTANT: Do not load envelopes with cutout or clear windows. 

Loading paper

Loading plain paper

The paper input tray capacity is 100 sheets of plain paper. 

1. Lift the paper input tray. 
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KODAK ESP 1.2 All-in-One Printer
2. Open the paper output tray, then pull the extender until it is fully extended.

3. Move the left and right paper-edge guides to the far left and far right positions. 

Paper output tray extender
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Handling Paper
4. Fan and stack the paper, then insert the paper into the paper input tray.

5. Move the paper-edge guides until they touch the paper. 
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KODAK ESP 1.2 All-in-One Printer
Loading photo paper 
The paper input tray capacity is 20 sheets of photo paper.

1. Lift the paper input tray. 

2. Open the paper output tray, then pull the extender until it is fully extended.

Paper output tray extender
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Handling Paper
3. Move the left and right paper-edge guides for loading photo paper. 

4. Insert photo paper (short side first) with the logo side toward the tray and the 
glossy side toward you.

IMPORTANT: Always load the paper short side first. The printer automatically detects 
the orientation of the picture, whether it’s portrait or landscape, and prints 
accordingly. If the photo paper is loaded incorrectly, the image will be cut off 
and the paper may jam. If the paper is loaded with the wrong side up, the 
image quality will be affected. 

5. Move the paper-edge guides until they touch the paper. 
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KODAK ESP 1.2 All-in-One Printer
Loading envelopes
The paper input tray capacity is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows. 

1. Lift the paper input tray. 

2. Open the paper output tray, then pull the extender until it is fully extended.

Paper output tray extender
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Handling Paper
3. Move the left and right paper-edge guides for loading envelopes. 

4. Insert the envelope(s) with the flap toward the tray and the top of the envelope 
against the right side of the tray.

5. Move the paper-edge guides until they touch the envelope(s). 
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5 Printing 
Print documents and lab-quality pictures on your printer. 

Printing documents
1. Open the document on your computer. 

2. Select File > Print.

3. In the Print dialog box, select your KODAK Printer. 

4. Choose the pages to print, number of copies, etc, then click OK (on a computer 
with WINDOWS OS) or Print (on a computer with MAC OS). 

Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts when 
you rotate the paper manually (see Paper sizes, page 19). 

IMPORTANT: You can print two-sided documents on media that can absorb ink on both 
sides, such as plain paper or two-sided photo paper. You cannot print 
two-sided documents on bar-coded photo paper (the bar code is on the 
back side). 

Printing two-sided documents from a computer with WINDOWS OS

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that KODAK ESP 1.2 AiO (or for a wireless 
connection, KodakESP1.2+XXXX, where XXXX is a number) is selected, then 
click Properties. 

4. Select the Layout tab. 

5. In the Two-sided printing field, select Manual, then click OK. 

NOTE: You can also select two-sided printing from the two-sided printing shortcut 
or from the General tab under the Job settings field.

6. Under “Flip on:”, select Long edge or Short edge, then click OK.

7. When a message appears on your computer and control panel, remove the 
printed pages from the paper output tray, then follow the instructions on the 
control panel.

8. Press . 
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Printing
Printing two-sided documents from a computer with MAC OS

1. Load paper into the paper input tray.

2. Open the document you want to print, then select File > Print.

3. In the Print dialog box, make sure that Eastman Kodak Company KODAK ESP 
1.2 AiO (or for a wireless connection, KodakESP1.2+XXXX, where XXXX is a 
number) is selected. 

4. In the Print dialog box, select the two-sided check box.

5. Click Print. 

6. When the even pages have finished printing, follow the instructions on the 
control panel to load the printed pages into the paper input tray.

7. Press .

Printing forms from the control panel

You can print the following forms:

• Graph paper

• Wide ruled page

• Narrow ruled page

• Grocery list

• Reminder list

• Tic-tac-toe

• Sheet music (portrait)

• Sheet music (landscape)

To print a form:

1. Press .

2. Press  to select Printable Forms, then press OK.

3. Press  to select a form. 

4. Press or  to select a quantity, then press OK. 

5. Press . 
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KODAK ESP 1.2 All-in-One Printer
Printing pictures from a memory card
You can print pictures from the following memory cards:

• SD Card

• SDHC Card

• MMC Card

• MEMORY STICK

• Variations of the memory cards listed above that require an adapter (for 
example, MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove 
the adapter and the memory card as a unit; do not remove the memory card 
while leaving the adapter in the printer.

You can also print pictures using Home Center Software from your computer with 
WINDOWS OS. Home Center Software lets you edit and enhance your pictures 
quickly. Open Home Center Software, select Edit and Print Pictures, then follow the 
on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from 
KODAK EASYSHARE Software or any picture-editing or photo-management 
software.

Viewing pictures on a memory card

When you insert a memory card into the card slot on your printer, press  to select 
View / Print Photos, then press  or  to scroll through the pictures. 

Finding pictures on a memory card

You can locate pictures on a memory card by the date the picture was taken or last 
saved.

To locate pictures: 

1. Insert the memory card into the memory card slot.

2. Press . 

3. Press  to select Find Photos, then press OK.

4. Press  to select Year, Month, and Day, then press  or  to set the values. 

The number of photos found for the date you specified appears under the menu 
name.

5. Press OK to view the pictures.
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Printing
Using default settings to print a picture
1. Load photo paper into the printer (see Loading photo paper, page 23).

2. Insert the memory card into the memory card slot.

3. Press  or  to display the picture you want to print. 

4. Press  to begin printing.

The printer prints one 4 x 6 in. / 10 x 15 cm picture. 

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing or viewing pictures.

memory card slot
30 www.kodak.com/go/aiosupport



KODAK ESP 1.2 All-in-One Printer
Changing the settings and printing pictures 

You can change the print photos options for an individual picture or group of 
pictures, or you can change the settings and save them as the default. 

1. Load photo paper into the printer (see Loading photo paper, page 23).

2. Insert the memory card into the memory card slot.

3. Press  or  to select the picture you want to print, then press OK.

4. Repeat step 3 for each picture you want to print.

5. Press  for Print Photos Options. 

6. Press  to select an option (see table below), then press  or  to change 
the setting. 

memory card slot

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the 
memory card; press OK to select the 
picture for printing; press  to display 
the Print Photos Options menu.

Find Photos -- Press OK, then select a year, month, 
and/or day to view photos by the date 
that they were taken; press OK to view 
the photo(s); press  to display the 
Print Photos Options menu.

Transfer to PC -- To transfer all the pictures on the 
memory card to your computer, press 
OK then . (Your printer and 
computer must be connected with a USB 
cable.)
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Printing
7. When you have finished changing settings, press .

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

Rotate This Photo To change the picture orientation, use 
the  and  buttons to rotate the 
photo. Press OK to save.

Quantity 1 (default) to 99 The number of copies that print. 

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected copy size is smaller than 
the paper in the paper input tray, the 
printer automatically arranges the 
pictures to best fit the paper size. 

Plain Paper Quality Normal (default) Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto
(default)

The printer detects photo paper in the 
paper input tray and sets Best quality 
automatically.

Scene Balance On (default)
Off 

Adjusts the image brightness to correct 
for underexposure and reduces the 
variation in contrast in different areas of 
the picture.

Add Date to Prints No (default)
Yes

Prints the date of the picture(s) (the 
date the picture was taken or last 
edited) in a corner of the print.

Save as Defaults No / Yes To save the settings as the new default, 
press OK. With Yes selected, press OK.

Print Photos Option Settings Description
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KODAK ESP 1.2 All-in-One Printer
Printing panoramic pictures

To print panoramic pictures, you will need to load 4 x 12 in. / 10 x 31 cm paper, or US 
letter or A4 paper.

1. Load 4 x 12 in. photo paper into the printer (see Loading photo paper, page 23).

2. Insert the memory card into the memory card slot. 

3. Press  or  to select the panoramic picture you want to print, then press OK.

4. Press  for Print Photos Options. 

5. Press  to select Print Size, then press  to select 4 x 12.

6. Press .

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing or viewing pictures.

memory card slot
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Printing
Printing tagged pictures
Some digital cameras let you tag (or “mark”) pictures on the memory card for 
printing. This creates a tag that is recognized by the printer. If you choose to print 
tagged pictures, they will be printed according to the default settings on your printer 
(unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine if your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1. Load photo paper into the printer (see Loading photo paper, page 23).

2. Insert the memory card into the memory card slot. 

3. When the message “Print tagged images?” appears, press .

memory card slot
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KODAK ESP 1.2 All-in-One Printer
Printing pictures from a wireless device
You can print pictures wirelessly at the touch of a button from: 

• iPhone (iOS 3.0 or later)

• iPod Touch (2nd generation)

• iPad

• BLACKBERRY Device (software v4.5 or later)

• a device running ANDROID OS v2.0 or later

For more information, see Mobile Printing, page 37, or go to 
www.kodak.com/go/mobile.

Transferring pictures to a computer
You can transfer your image files from a memory card in the printer to your 
computer. To transfer these files, the printer must be connected to your computer 
with a USB cable.

NOTE: If you have large video files or a large number of pictures (400 or more), we 
recommend that you transfer them using a memory card reader attached 
directly to your computer. 

Transferring pictures to a computer with WINDOWS OS
1. Insert the memory card into the memory card slot on the printer. 

2. Press .

3. Press  to select View / Print Photos, then press OK. 

4. Press  to select Transfer to PC, then press OK.

5. Press .

6. If your computer is connected to a wireless network and with a USB cable, select 
the USB printer (no number after the printer name).

7. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS
1. Insert the memory card into the memory card slot on the printer.

2. Press .

3. Press  to select View / Print Photos, then press OK.

4. Press  to select Transfer to PC, then press OK.

5. Press .

6. If your computer is connected to a wireless network and with a USB cable, select 
the USB printer.

7. Use iPhoto or Image Capture Software on your computer to complete the 
transfer.
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Printing
Printing picture collages using KODAK Photo Collage Print App
KODAK Photo Collage Print App is a FACEBOOK Application that allows you to 
create and print photo collages from FACEBOOK albums.

Adding KODAK Photo Collage Print App to your FACEBOOK Account:

1. Log on to your FACEBOOK Account.

2. Go to apps.facebook.com/kodakcollage.

3. Click Allow. The application opens. 

Printing from KODAK Photo Collage Print App:

1. Click the Templates button.

2. Select the template you want to use.

3. Select the Select Photos tab. 

4. Click the triangles on the left side of the screen to view FACEBOOK photo 
albums, then select the photo albums you want to use.

NOTE: You can use your albums, your friends’ albums, or both.

5. Click the Template tab to choose a layout design. 

6. Hover your mouse over a photo to show the editing tools.

The editing tools allow you to:

• refresh the photo, which swaps the photo with another in your chosen 
album(s)

• pan and zoom

• move a photo from one position to another on the collage

7. When you finish the collage, click Continue.

8. To share your collage, click Share. The collage will be posted to your FACEBOOK 
wall and will be saved to your FACEBOOK photo albums.

9. To print your collage:

• Load 8.5 x 11 in. (22 x 28 cm) photo paper into your printer

• Click Print.
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6 Mobile Printing 
Mobile printing lets you print to your all-in-one printer from your Web-connected 
mobile device. 

When your:

• printer is registered to Google Cloud Print™, you can print from anywhere with 
your mobile device using Google Cloud Print apps.

• printer has an email address (assigned by KODAK Email Print Service), you can 
send emails and email attachments to your printer from anywhere, from a 
device capable of sending email.

• mobile device is connected to the same wireless network as your printer, you 
can print pictures using a KODAK Pic Flick App.

When you plan to use mobile printing, make sure that your printer power is on or 
your printer is in low power mode (for information, see Time to Low Power under 
Configuring printer settings, page 5). 

Printing using Google Cloud Print
Print on the go from your smartphone, computer, or tablet using Google Cloud Print 
enabled apps. 

Before you can use Google Cloud Print, make sure your printer is set up for Google 
Cloud Print. See Registering your printer with Google Cloud Print™, page 16.

Printing varies by application. For more information, go to 
www.google.com/cloudprint/learn/apps.html.

To print from a Chromebook:

Click the wrench and select Print to print the Web page you are viewing (you can 
also use the keyboard shortcut Ctrl+P). 

To print from an iOS mobile device (iPhone, iPad, iPod Touch): 

• From GMAIL:

– Email body: Select the email, then click the menu in the top-right corner and 
select Print. 

– Attachment: Click the Print button next to the attachment. 

• From GOOGLE DOCS Program: 

– Select the document, then click the menu in the top-right corner and select 
Print. 

To print from an ANDROID OS device:

Install the Google Cloud Print App from the ANDROID Market. 
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Mobile Printing
To print from a computer: 

Install the CHROME Extension (plug in) from the CHROME Web store, then: 

• From GMAIL:

– Email body: Select the email, then click the Print all using Google Cloud Print 
link at the top right of the email. 

– Attachment: Select Print attachment using Google Cloud Print. 

• From GOOGLE DOCS Program: 

– Select File > Print using Google Cloud Print. 

• Web pages (URL must end with .pdf, .doc, or .txt): 

– Click Print using Google Cloud Print when it appears on the URL address bar. 
– For the latest information on supported formats, go to the CHROME 

Extension (plug in) Web site. 

To print from a BLACKBERRY OS device:

We recommend using KODAK Email Print. 

Printing using KODAK Email Print Service

Printing emails, documents, and pictures

KODAK Email Print lets you send emails and email attachments (documents and 
pictures) to your printer from anywhere, using any device capable of sending email. 

NOTE: Before you can use KODAK Email Print, your printer must be registered to 
Google Cloud Print™ (see Registering your printer with Google Cloud 
Print™, page 16), and your printer must have an email address assigned by 
KODAK Email Print (see Registering your printer with KODAK Email Print 
Service, page 17).

To print using KODAK Email Print:

1. Make sure that your device or computer is connected to the Internet.

2. Open an email application (such as GMAIL, MICROSOFT OUTLOOK, 
HOTMAIL, YAHOO, iOS Mail, or ANDROID OS Mail).

3. Address the email to your printer email address. Attach the files you want to 
print; if needed, include any comments in the body of the email.

4. Send the email. 

The email attachments (and any comments) will print to your printer. 
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KODAK ESP 1.2 All-in-One Printer
Printing pictures from a mobile device
When connected to the same Wi-Fi network, you can print pictures wirelessly with 
your all-in-one printer from: 

• an iPhone (iOS 3.0 or later), iPod Touch device (2nd generation), iPad (may not 
be available with all models).

• a BLACKBERRY Device (software v4.5 or later).

• a device running ANDROID OS v2.0 or later.

Download the KODAK Pic Flick App from the App Store directly from your device, 
then follow the procedure for your device. For information, go to 
www.kodak.com/go/mobile.

Printing pictures from an iPhone, iPad, or iPod Touch device
IMPORTANT: Requires iOS 3.0 or later. 

To print a picture from an iPhone, iPad, or iPod Touch device (2nd generation):

1. Make sure your device is connected to the same Wi-Fi network as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print, then select Choose Device.

4. Select your KODAK All-in-One Printer from the list of available devices.

5. Select Send.

Printing pictures from a BLACKBERRY Device

To print a picture from a BLACKBERRY Device (software v4.5 or later):

1. Make sure your BLACKBERRY Device is connected to the same Wi-Fi network 
as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print.

4. Press the Menu key, then select Print. 

5. Select your KODAK All-in-One Printer from the list of available devices.

NOTE: It may take a few minutes for the printer to appear in the Available 
Printers list.

6. Select the print size and enter the number of copies.

7. Select Print.
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Mobile Printing
Printing pictures from an ANDROID OS Device

To print a picture from a device running ANDROID OS v2.0 or later:

1. Make sure your device is connected to the same Wi-Fi network as your printer.

2. Open the KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print.

4. Select View/Edit to edit the picture(s), or go to step 5.

a. Press and hold the screen to enter the edit mode.

b. Rotate, move, pan, zoom, or crop the picture. 

5. Press Select Device, then select your KODAK All-in-One Printer.

6. Select the print size.

7. Press Back, then select Send.
40 www.kodak.com/go/aiosupport



KODAK ESP 1.2 All-in-One Printer
Printing pictures and documents from an ANDROID OS Device
NOTE: ANDROID OS v2.0 or later required.

To print a picture using KODAK Pic Flick App:

1. Make sure your device is connected to the same Wi-Fi network as your printer.

2. Open KODAK Pic Flick application on your device.

3. Select the picture(s) you want to print.

4. Select View/Edit to edit the picture(s), or go to step 5.

a. Press and hold the screen to enter the edit mode.

b. Rotate, move, pan, zoom, or crop the picture. 

5. Press Select Device, then select your KODAK All-in-One Printer.

6. Select the print size.

7. Press Back, then select Send.

To print a picture or document using KODAK Document Print App:

IMPORTANT: Before you can use KODAK Document Print App, your printer must be 
registered to Google Cloud Print™ (see Registering your printer with Google 
Cloud Print™, page 16).

1. Download and install the app from the ANDROID Market.

2. Launch the KODAK Document Print App.

3. Locate the picture or document you want to print. 

4. Sign in with your GOOGLE Account, then select OK.

5. Select your printer from the list.

6. Select Print.
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7 Copying
You can copy documents and pictures with your all-in-one printer. The printer 
produces high–quality color or black-and-white copies on a variety of paper (see 
Paper types, page 18). 

Copying a document
You can copy a document using the default settings, or you can adjust the quantity, 
size, quality, and brightness of your copies. 

Using the default settings to copy a document 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 74), or defaults that you have set on the printer (see Save as Defaults, 
page 44). 

To copy a document using the current default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner 
of the scanner glass.

2. Close the lid.

3. Press .

4. Press  to select Copy Document, then press OK.

5. Press . 
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KODAK ESP 1.2 All-in-One Printer
Adjusting the settings and copying a document
1. Lift the scanner lid, and place the document face down in the right-front corner 

of the scanner glass.

2. Close the lid. 

3. Press . 

4. With Copy Document selected, press OK.

5. Press  to select an option, then press  or  to change the setting.

Copy Document 
Option

Setting Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper input 
tray, and automatically reduces or 
enlarges the original so that the copy 
fits on the paper.

20% to 500% Reduces to 20% or enlarges to 500% 
of the original size.
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Copying
6. Press . 

Plain Paper Quality Normal
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto.
(default)

The printer detects photo paper in the 
paper input tray and sets Best quality 
automatically.

Brightness Normal (default)

3 to +3 

Lightens or darkens the copy. 
Normal is no change from the original; 
3 is the darkest; +3 is the lightest.

Save as Defaults No / Yes To save the settings as the new 
defaults, press OK. With Yes selected, 
press OK.

Copy Document 
Option

Setting Description
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KODAK ESP 1.2 All-in-One Printer
Changing the number of copies of a document
1. Lift the scanner lid, and place the document face down in the right-front corner 

of the scanner glass.

2. Close the lid. 

3. Press . 

4. With Copy Document selected, press  or  to select a quantity.

5. Press . 
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Copying
Enlarging or reducing a document
1. Lift the scanner lid, and place the document face down in the right-front corner 

of the scanner glass.

2. Close the lid. 

3. Press . 

4. With Copy Document selected, press OK. 

5. Press  to select Copy Size.

6. Press  or  to select an enlargement or reduction.

7. Press . 
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KODAK ESP 1.2 All-in-One Printer
Darkening or lightening a document
1. Lift the scanner lid, and place the document face down in the right-front corner 

of the scanner glass.

2. Close the lid. 

3. Press . 

4. With Copy Document selected, press OK. 

5. Press  to select Brightness.

6. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

7. Press . 
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Copying a photo
You can copy a photo using the default settings, or you can adjust the quantity, size, 
quality, and brightness of your copies. 

Using the default settings to copy a photo 

The default settings are either the factory default settings (see Resetting factory 
defaults, page 74), or defaults that you have set on the printer (see Save as Defaults, 
page 50). 

1. Load photo paper into the printer (see Loading photo paper, page 23).

2. Lift the scanner lid, and place the photo face down in the right-front corner of 
the scanner glass.

3. Close the lid. 

4. Press . 

5. Press  to select Copy Photo.

6. Press . 
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Adjusting the settings and copying a photo
1. Lift the scanner lid, and place the photo face down in the right-front corner of 

the scanner glass.

2. Close the lid. 

3. Press . 

4. Press  to select Copy Photo, then press OK. 

5. Press  to select an option, then press  or  to change the setting. 

Copy Photo Option Setting Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper input tray, 
and automatically reduces or enlarges 
the original so that the copy fits on the 
paper.
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6. Press .

Plain Paper Quality Normal 
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Auto.
(default)

The printer detects photo paper in the 
paper input tray and sets Best quality 
automatically.

Brightness Normal (default)
3 to +3 

Lightens or darkens the copy. 
Normal is no change from the original; 
3 is the darkest; +3 is the lightest.

Preview No (default)
Yes

To see a preview of the photo on the 
LCD, select Yes. 

Save as Defaults No / Yes To save the settings as the new defaults, 
press OK. With Yes selected, press OK.

Copy Photo Option Setting Description
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Changing the number of copies of a photo
1. Lift the scanner lid, and place the photo face down in the right-front corner of 

the scanner glass.

2. Close the lid. 

3. Press .

4. Press  to select Copy Photo, then press OK.

5. Make sure Quantity is selected. 

6. Press  or  to select a quantity. 

7. Press . 
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Enlarging or reducing a photo
1. Lift the scanner lid, and place the photo face down in the right-front corner of 

the scanner glass.

2. Close the lid. 

3. Press .

4. Press  to select Copy Photo, then press OK.

5. Press  to select Copy Size.

NOTE: Make sure that the paper loaded in the paper input tray is at least as wide 
as the Copy Size selected, or you will get a wrong paper size error. Also, if 
the loaded paper is not as long as the Copy Size selected, the output 
picture will be cut off without any warning.

6. Press  or  to select the copy size.

7. Press .
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Darkening or lightening a photo
1. Lift the scanner lid, and place the photo face down in the right-front corner of 

the scanner glass.

2. Close the lid. 

3. Press .

4. Press  to select Copy Photo, then press OK.

5. Press  to select Brightness.

6. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

7. Press . 
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8 Scanning
Scanning digitizes documents and pictures, and sends the digital files to your 
computer or memory card.

When you scan, the digital file can: 

• open in Home Center Software (when Home Center Software is loaded and the 
printer is connected to a computer with WINDOWS OS)

• open in a third-party scanner software 

• be saved in a format and location that you determine (see Changing the scan 
settings for scanning from the printer control panel, page 55)

Scanning from a software program on the computer (such as Home Center 
Software) gives you more options, but you can also scan from the printer control 
panel. 

Before you begin scanning
If you are scanning to a computer, make sure that the printer is connected to a 
computer using a USB 2.0 cable or wireless network (see Networking Your Printer, 
page 6). If you plan to scan directly from the printer control panel, you can change 
the settings as described below.
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Changing the scan settings for scanning from the printer control panel

If you want to adjust the scan settings that the printer uses, do so before you scan 
from the printer control panel.

1. Open Home Center Software, then open the Printer Tools (WINDOWS OS) or 
Tools (MAC OS) window.

NOTE: To get to Printer Tools without Home Center Software (WINDOWS OS 
only), select Start > All Programs > Kodak > KODAK AiO Printer Tools.

2. Under the Tools heading, select Printer Scan Settings. 

3. Adjust settings for scanning documents and pictures:

a. To select a program that scanned images or documents will appear in when 
you scan from the printer control panel: 

(1) Select the General tab.

(2) Under the Program List heading, click  next to the currently selected 
program.

(3) From the drop-down list, select the program in which you want the 
scanned files to open. 

b. To adjust settings for scanning documents, select the Document tab, then 
select an option for each setting:

Setting Options

File format .pdf 
.rtf (available only when connected to a computer 

with WINDOWS OS)
.tif 

.jpg

.bmp (available only when connected to a computer 
with MAC OS)

Resolution (dpi) 75
150
200 
300

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are named 

“scan1”, “scan2”, and so on.
• Location (folder) where the scanned files will be 

saved
www.kodak.com/go/aiosupport 55



Scanning
c. To adjust settings for scanning pictures, select the Picture tab, then select an 
option for each setting:

NOTE: Before you save a scanned file in Home Center Software, you can 
preview, crop, and sharpen the image, and adjust the color. On a 
computer with WINDOWS OS, see the Home Center Software Help 
(? icon) for instructions.

Setting Options

Scan As Color 

Black and white

File format .jpg
.bmp
.tif

Resolution (dpi) 75
150
200

300

600

Quality When connected to a computer with 
WINDOWS OS:

• Best for E-mail
• Normal
• High
• Maximum
When connected to a computer with MAC OS, 
a slider bar with:
• Least
• Medium
• Best

Automatically Detect 
Pictures (when connected 
to a computer with 
WINDOWS OS) or Auto 
Crop (when connected to a 
computer with MAC OS)

When selected, multiple pictures placed on the 
scanner glass are saved as separate files.

File Save Prompt for File Name and Location
Automatically Save - specify:
• Base name; by default, scanned files are named 

“scan1”, “scan2”, and so on
• Location (folder) where the scanned files will be 

saved
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4. When you are finished making selections, click OK on the bottom right of the 
Printer Scan Settings window. 

5. Close the Printer Tools window. 

Scanning from the control panel
When you scan a document or picture(s) from the control panel, you have the 
following options: 

• Scan to Computer - scans to a file or to Home Center Software on your 
computer

• Scan to Memory Card - scans to a memory card in the memory card slot 

Scanning to a computer
1. Lift the scanner lid, and place the document or picture face down on the glass, 

then close the lid.

2. Press .

3. Press  to select Scan, then press OK.

4. Select Scan to Computer, then press OK. 

5. Press  to select an option, then press or  to change the setting.

Scan Option Settings Description

Scan To USB Computer
(default)

The scanned file is sent to the USB Computer.

Name of computer 
(only if a computer 
is connected by 
wireless network)

The scanned file is sent to the computer on the 
wireless network.
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6. Press . The scanned file appears at the destination you specified.

Scan What Document
(default)

Sets the scan settings for scanning a document 
(see Changing the scan settings for scanning 
from the printer control panel, page 55). 

Photo Sets the scan settings for scanning a picture 
(see Changing the scan settings for scanning 
from the printer control panel, page 55).

Scan Dest. 

(Destination)
File
(default)

Sends the scanned file in the format and to the 
location on your computer that you designate.

Application 
(available only 
when Home 
Center Software is 
installed on 
computer)

Sends the scanned file to Home Center 
Software.

Save as 
Defaults

No / Yes To save the settings as the new defaults, press 
OK. With Yes selected, press OK.

Scan Option Settings Description
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Scanning to a Memory Card
1. Lift the scanner lid, and place the document or picture face down on the glass, 

then close the lid.

2. Press .

3. Press  to select Scan, then press OK. 

4. Press  to select Scan to Memory Card, then press OK.

5. Press  to select an option, then press  or  to change the setting.

Scan Option Settings Description

Scan What Photo
(default)

Sets the scan settings for scanning a picture 
(see Changing the scan settings for scanning 
from the printer control panel, page 55). 

Document Sets the scan settings for scanning a document 
(see Changing the scan settings for scanning 
from the printer control panel, page 55).

File Type JPG (default) Saves the scanned file as a .jpg file.

Single-page PDF Saves the scanned file as a single-page PDF. 

Multi-page PDF Saves the scanned file as a multi-page PDF.
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6. Press . The scanned file appears at the destination you specified. 

Scan Size Auto (default)
2 x 3 
3.5 x 5
4 x 6
4 x 7 
4 x 8 
5 x 7
4 x 12
8 x 10
8.5 x 11
A4
8.5 x 14

Determines the size that is scanned.

Save as 
Defaults

No / Yes To save the settings as the new defaults, press 
OK. With Yes selected, press OK.

Scan Option Settings Description
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Scanning from the computer
1. Lift the scanner lid, and place the document or picture face down in the 

right-front corner of the glass.

2. Close the lid.

3. Open Home Center Software. 

• On a computer with WINDOWS OS, select Scan Documents and Pictures, 
then follow the on-screen instructions.

• On a computer with MAC OS, select the Tools tab, click Scan Application, 
then follow the on-screen instructions. 

NOTE: If you are not using Home Center Software, open a program that allows you 
to scan, then follow the instructions.
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Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and 
save them as separate files. 

When scanning multiple pictures, leave space between the pictures so that the 
printer can detect the separate pictures. Any pictures that overlap are interpreted as 
a single picture. 

Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select Printer Tools.

4. Click Printer Scan Settings, then select the Picture tab.

5. Select Automatically Detect Pictures, if it is not selected, then click X to close 
the Printer Scan Settings.

6. Select Scan Documents and Pictures on the main screen of Home Center 
Software.

7. Make sure that Picture is selected and Collage - Combine all pictures is cleared, 
then follow the on-screen instructions.

NOTE: Click the Help (? icon) for more information. 

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select your printer.

4. Select the Tools tab.

5. Click Scan Application.

6. Select Color Picture or Black and White Picture. 

7. Select Automatically detect multiple pictures, if it is not selected.

8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click the Help (? icon) for more information. 
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9 Maintaining Your Printer
Your printer requires little maintenance. However, Kodak recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the 
quality and accuracy of scanning and copying.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. 
If you use a power strip, don't turn off the power strip. (The printer does not need to 
be turned on but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent 
damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, 
go to the Electronics Industry Alliance at www.eia.org or go to 
www.kodak.com/go/recycle. 

General care and cleaning
CAUTION:

Always disconnect the power to the printer before cleaning it. Do not use 
harsh or abrasive cleaners on any part of the printer.

• To clean the printer, wipe the outside with a clean, dry cloth.

• Keep the surrounding area vacuumed and litter-free. 

• Protect the printer from tobacco smoke, dust, and liquid spills. 

• Do not place objects on the printer. 

• Keep the paper trays free of dust, dirt, and other foreign objects. 

• Keep the printer supplies away from direct sunlight and out of high-temperature 
environments.

• Do not allow chemicals to come into contact with the printer. 
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Maintaining Your Printer
Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing. 

CAUTION:
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass.
Do not use paper-based wipes on the document backing as they can 
scratch it.

1. Turn off the printer and unplug it from the power outlet. 

2. Lift the scanner lid. 

Document backing

Scanner glass
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3. Wipe the glass with a soft cloth or sponge, slightly moistened with a 
nonabrasive glass cleaner. 

4. Dry the glass with a lint-free cloth.

5. Gently clean the document backing with a soft cloth or sponge, slightly 
moistened with mild soap and warm water. 

6. Dry the document backing with a chamois or lint-free cloth.

NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) 
alcohol on a soft cloth, then wipe thoroughly with a cloth moistened 
with water to remove any residual alcohol. 

7. When you finish cleaning, plug in the printer.
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Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate 
ink levels on the LCD (see Checking ink levels, page 74) or in Home Center Software. 
When an ink cartridge is out of ink, the printer LCD displays a message stating that 
the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

To replace an ink cartridge: 

1. Make sure your printer is on.

2. Lift the access door, and wait for the carriage to move to the access position. 

The ink cartridges are located in the printhead. 

Black 
ink cartridge

Color ink cartridge

Printhead 
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3. Pinch the tab on the ink cartridge. 

4. Lift the ink cartridge out of the printhead. 

5. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.
www.kodak.com/go/aiosupport 67



Maintaining Your Printer
6. Remove the cap.

7. Insert the ink cartridge into the printhead.

8. Press down on the ink cartridge tab until you hear a click.

9. Close the access door. 
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Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Kodak.

To replace the printhead:

1. Make sure your printer is on.

2. Lift the access door, and wait for the carriage to move to the access position.

3. Remove both ink cartridges and set them aside. 
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4. Unlatch the printhead by pushing the button in the center of the carriage.

5. Lift the printhead out of the carriage.

6. Remove the new printhead from its bag.
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7. Remove the protective cap from the new printhead.

8. Install the printhead into the carriage.

9. Push firmly against the target label of the printhead until you hear a loud snap.
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10. Insert the black ink cartridge into the printhead. 

11. Press down on the ink cartridge until you hear a click.

12. Repeat steps 10 - 11 for the color ink cartridge. 

13. Close the access door. 

The printer detects the new printhead. Follow the instructions on the control 
panel to calibrate your printer. 
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Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your 
printer. 

NOTE: Firmware is the software that runs on your printer.

Although there is an automatic background check for software and firmware 
updates when your computer is connected to the Internet, you can update manually 
using the following procedure. 

Updating if your printer is connected to a computer with WINDOWS OS

To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software, then select Printer Tools.

NOTE: If you do not have Home Center Software, select Start > All Programs > 
Kodak > KODAK AiO Printer Tools. 

3. Under Printer Resources, click Check for Software Updates.

4. If there are updates, click Next and follow the on-screen instructions. 

To update the firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Open Home Center Software, then select Printer Tools.

4. Make sure that your printer name appears in the lower left corner of the Printer 
Tools window followed by Connected.

NOTE: If the printer name does not appear, click Select, then click Refresh List 
and choose your printer from the list; click OK and follow the on-screen 
instructions. 

5. Under Printer Resources, click Check for Printer (Firmware) Updates.

6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or disconnect your printer or your computer during the 
update. Doing so may cause the printer to become inoperable. If the printer 
is connected wirelessly, make sure you have a stable connection when you 
perform the update. During the upgrade, your printer will restart. Wait for 
the message, “Update complete! You may now use your Kodak Printer” to 
appear on your computer.
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Updating if your printer is connected to a computer with MAC OS
To update the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. Select the Tools tab.

4. Click Check for Software Updates.

5. If there are updates, follow the on-screen instructions.

To update the firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable or wirelessly (if not 
currently connected). 

3. Open Home Center Software. 

4. Select the Tools tab.

5. Click Check for Printer (Firmware) Updates.

6. If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. 
Doing so may cause the printer to become inoperable. Your printer will 
restart during the upgrade.

Checking ink levels
1. Press .

2. Press  to select Maintenance, then press OK.

3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges. 

NOTE: You can order ink cartridges online. Go to 
www.kodak.com/go/printingsupplies.

Resetting factory defaults
1. Press .

2. Press  to select Printer Settings, then press OK.

3. Press  to select Reset All Settings, then press OK. 

4. When you see the message, “This will reset printer settings to factory defaults,” 
press OK.

NOTE: Resetting factory defaults does not change the date and time, language, 
country/region, or network settings.
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10 Troubleshooting

Basic troubleshooting
If you experience a problem with your printer, restarting it will sometimes fix the 
issue. Turn off your printer, wait five seconds, then turn on your printer.

If you are still experiencing a problem, use the following information to troubleshoot 
your printer.

Problem Possible Solutions

Printer does not 
power on

• Make sure you are using the power cord that came with your printer. 
• Make sure the power cord is connected to the AC adapter, it is plugged into an 

outlet or power strip, and that the LED on the AC adapter is lit. 
• Make sure that the power cord is securely connected to the power cord port in the 

back of the printer.

Printer not detected • Make sure your printer is plugged in and turned on.
• If you are using a USB cable, make sure that: 

– it is a USB 2.0 high-speed cable.
– it is connected to both your printer and your computer.
– you restart the computer if the USB cable was disconnected from the printer 

then reconnected, or if power to the printer was interrupted.
• If you are using a wireless connection, make sure that:

– the Wi-Fi connectivity LED on the printer is glowing steadily. 
– the printer is connected to your wireless network.

To check:

a. On the printer, press .

b. Press  to select Network Settings, then press OK.
c. Press  to select View Network Configuration, then press OK. 

Make sure that the Active Connection Type is Wi-Fi, and that the IP Address 
is not 0.0.0.0. 

– your router is transmitting data.
– the firewall (excluding WINDOWS Firewall) is allowing the services needed for 

your printer. 

For more information, go to www.kodak.com/go/inkjetnetworking.

Wireless connectivity For wireless connectivity issues, go to www.kodak.com/go/inkjetnetworking.

Carriage jam • Open the access door and clear any obstructions.
• Make sure the printhead and ink cartridges are installed correctly.

(The printhead and ink cartridges are installed correctly when you hear them click 
into place.)
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Print quality • For best results, use paper with the COLORLOK Technology logo on the package.
• Make sure the paper is loaded correctly. See Loading paper, page 20. 
• Clean the printhead:

– Press .
– Press  to select Maintenance, then press OK.
– Press  to select Clean Printhead, then press OK.

• Calibrate the printer:

– Press .
– Press  to select Maintenance, then press OK.
– Press  to select Calibrate Printer, then press OK.

• For more information, go to www.kodak.com/go/esp1_2support, then type the 
problem in the search field.

Ink cartridge • Make sure KODAK Ink Cartridge(s) are installed. Do not use non-Kodak brand or 
refilled ink cartridges. 

• Remove, then install the cartridges again. Make sure the cartridges click into place.

Paper jam • Open the access door and gently remove any paper from inside the printer. 
• Make sure the paper in the tray is free of tears or creases.
• Make sure you do not overload the paper input tray.
For more information, go to www.kodak.com/go/esp1_2support, then type jam in the 
search field.

Error codes/messages 
or other problems 
you cannot resolve

• Go to www.kodak.com/go/esp1_2support, then type your error code or message. 
If you need to contact Kodak (see www.kodak.com/go/contact), have the following 
information available:

• Kodak Service Number (located inside the printer when you open the access door)
• Printer model number (located on the control panel)
• Computer model, operating system, and version of Home Center Software
• Exact wording of any error message(s) and the error code

Problem Possible Solutions
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Getting help on the Web
For more troubleshooting information:

Get help with wireless networking. www.kodak.com/go/inkjetnetworking

Search our knowledge base of Questions and 
Answers.

www.kodak.com/go/esp1_2support

Download the latest firmware and software for 
optimal printer performance.

www.kodak.com/go/esp1_2downloads

Get help with problems you cannot resolve. Contact Kodak at www.kodak.com/go/contact and have the 
following information available: 

– Kodak Service Number (located inside the printer when you 
open the access door)

– Printer model number (located on the control panel)
– Computer model, operating system, and version of Home 

Center Software
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Troubleshooting
Status lights
The status lights indicate the condition of the printer. There are two status lights on 
the printer: one on the on/off button that indicates power, the other indicates Wi-Fi 
status.

Power light

Wi-Fi connectivity LED 

Power light What it means

Off • The printer is turned off.

– Press the power button to turn on power.

• The printer does not have power.

– Make sure that the power cord is plugged into the 
back of the printer and into an electrical outlet, and 
that the electrical outlet has power.

Blinking • The printer is busy.

– Wait for the printer to finish the task.

On • The printer is ready.

Wi-Fi connectivity LED What it means

Off The Wi-Fi radio is either turned off or is turned on but not 
connected to a wireless network.

Blinks continuously The Wi-Fi radio is turned on, and the printer is searching for 
available wireless networks within range.

Blinks intermittently The Wi-Fi radio is turned on and the printer cannot find any 
available wireless networks within range, or the Wi-Fi radio 
connection has been interrupted, or is too weak to send 
signals to and from the printer.

To find and connect to an available wireless network within 
range, press OK, turn the Wi-Fi radio off, and run the Wi-Fi 
Setup Wizard (see Connecting to a wireless network, 
page 6).

On The Wi-Fi radio is turned on, and there is a working 
connection between the printer and a wireless network.
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11 Product and Safety Specifications
The following specifications are subject to change without notice.

Specifications and features

Print performance

Photo printing features

Copy document features

Black print speed 8 images per minute

Color print speed 4.5 images per minute

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper
Best on photo paper

Quantity 1 to 99 

Print sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 
5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Best, Normal, Draft modes on plain paper

Best on photo paper (automatically selected)

Auto-detect media Auto-detect plain paper and photo papers
Optimize image quality for KODAK Photo Papers with barcode

Image enhancement KODAK PERFECT TOUCH Technology with Home Center 
Software

Add date to prints No (default), Yes

Color Black and white or color

Scene balance On (default), Off

Color Black and white or color

Quantity 1 to 99 copies 

Copy sizes Same Size, Fit-to-Page, 20 to 500% 

Plain paper quality Best, Normal, Draft

Brightness 3 to + 3
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Copy photo features

Scanning features

Paper input tray features

Color Black and white or color

Quantity 1 to 99 copies 

Copy sizes 2 x 3 in. / 5 x 8 cm
3.5 x 5 in. / 9 x 13 cm
4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 30 cm (Panoramic) 
5 x 7 in. / 13 x 18 cm
8 x 10 in. / 20 x 25 cm
US Letter - 8.5 x 11 in. / 22 x 28 cm
A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Automatic

Brightness 3 to + 3

Scanner type Contact Image Sensor (CIS)

Maximum scan size 8.5 x 11.7 in. / 22 x 30 cm

Resolution and
Bit Depth

Supports native scan resolution of 2400 dpi
Scans at 8 bits per channel, with 3-color scans at 24 bits/pixel

Functions Segmentation scanning
Auto-destination
OCR
Auto picture detection

Paper capacity 100 sheets of 20 lb plain paper
20 sheets of photo paper, up to 12 mil (290 gsm)
20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm
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Paper types supported

Paper sizes supported

Plain paper 16 to 24 lb (60 to 90 gsm)

Photo paper Up to 12 mil (290 gsm)

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Labels All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets 

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm.)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4 to 8.5 in. / 10 to 22 cm wide and 
6 to 14 in. / 15 to 36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. / 10 x 15 cm cards 

5 x 7 in. / 13 x 18 cm index cards 

Iron-on transfers A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Envelopes C5 (6.7 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (11 x 22 cm / 4.3 x 8.7 in.)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)

US #10 (4.1 x 9.5 in / 10.5 x 24 cm)
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Ink cartridges

Connectivity

Software support

Photos 4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 31 cm

5 x 7 in. / 13 x 18 cm

7 x 10 in. / 18 x 25 cm

8 x 10 in. / 20 x 25 cm

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)

Ink handling 2-cartridge, 4-ink system

Ink life 1-year warranty from date of purchase

Protocols supported USB 2.0 High Speed; DPOF

Devices supported WINDOWS OS-based and MACINTOSH Computers, memory 
cards (SD, MS/Duo, MMC, SDHC) 

Image Formats supported Image printing supports JPEG (EXIF v2.2); does not support 
progressive JPEG format

Protocols supported USB 2.0 High Speed (for connection to computer only), DPOF 
(Tagged image printing)

Wi-Fi Technology
supported

802.11b/g/n, WPA/WPA2, and WPS

Application support Third-party image management applications; optical character 
reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, labels, and 
iron-on transfers

Scanner support TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), ICA 
(MAC OS), including segmentation scanning

Update support Software and firmware updates available through Web support
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Physical specifications

Warranty

System requirements

Computer with WINDOWS OS

Power Input: 100–240 V AC, 50–60 Hz 
The printer should only be used with a switching adapter.

Manufacturer and model: 

Asia Power Devices Inc., Model DA-18A36

Chicony Power Technology Co., Ltd, Model A10-018N3A

Storage Dimensions 16.9 in. (43.0 cm) long x 12.6 in. (32.0 cm) wide x 6.7 in. 
(17.0 cm) high

Operating Dimensions 16.5 in. (42.0 cm) long x 19.8 in. (50.3 cm) wide x 12.0 in. 
(30.5 cm)

Weight 12.7 lb (5.8 kg) with power supply, printhead, and ink cartridges

Operating range 41 to 95°F (5 to 35°C), 15 to 85% RH 

Full image quality
environmental range

59 to 86°F (15 to 30°C), and 20 to 80% RH. 

Energy efficiency ENERGY STAR® Qualified All-in-One Printer

Printer One year from purchase (with proof of purchase)

Printhead One year from purchase (with proof of purchase)

Minimum

Operating system WINDOWS 7, VISTA, or XP (SP2 or later)

CPU INTEL CELERON Processor

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 2.0 High Speed

Removable drive CD-ROM
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Computer with MAC OS
Minimum

Operating system MAC OS X 10.5 or later

CPU PowerPC G4, G5, or INTEL-based MAC

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 200 MB available

Interface USB 2.0 High Speed

Removable drive CD-ROM
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Safety information
KODAK ESP 1.2 All-in-One Printers are Class 1 LED Products.

• Always follow all warnings and instructions marked on the product.

• Use only the power source provided with the product.

• Use only the power cord that comes with the product (or an approved power 
cord greater or equal to H05W-F, 2G, 0.75mm2). Using another power cord may 
cause fire and/or shock. Do not use the included power cord with any other 
equipment. 

• If you do not use this product for a long period of time, unplug it from the 
electrical outlet.

• Always turn this product off by using the On/Off button. Wait until the On/Off 
button stops flashing before removing the power plug from the outlet. 

• Do not allow the power cord to become damaged or frayed.

• If you need to use an extension cord with this product, make sure that the 
ampere rating of the product does not exceed the ampere rating of the extension 
cord.

• Place the product on a flat, stable surface that extends beyond the product’s 
base in all directions. This product will not operate properly if tilted or at an 
angle.

• When storing or transporting this product, do not tilt or stand it on its side. 
Never turn this product upside down (ink can leak out of the product).

• Avoid placing this product in an environment that is subject to rapid changes in 
temperature or humidity, mechanical shocks, vibration, or dust. Do not place 
near radiators, heating vents, or in direct sunlight.

• Leave enough room around this product for sufficient ventilation. 

• Do not block this product’s covers or openings, or insert any objects through slots. 

• Do not use aerosol products inside or around this product.

• Do not spill any liquid on this product.

• Do not attempt to repair or service this product.

• If the power cord or plug is damaged, if any liquid has been spilled onto the 
product, if the product has been dropped or the case damaged, if the product 
does not operate normally or exhibits a major change in performance level, 
unplug this product and contact Kodak at www.kodak.com/go/contact.
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LCD screen safety

• Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or 
chemical cleaners.

• If the LCD screen is damaged, contact Kodak immediately. If any of the solution 
from the display gets on your hands, wash them thoroughly with soap and water. 
If the liquid crystal solution gets into your eyes, flush your eyes immediately 
with water. If any discomfort or change in vision persists after washing, seek 
medical attention immediately.

Ink cartridge safety

• Keep all ink cartridges out of the reach of children.

• If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 
immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.

• For Material Safety Data Sheets (MSDS) information on inks, go to 
www.kodak.com/go/MSDS.

NOTE: You will need the Catalog number from the ink package.
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KODAK ESP 1.2 All-in-One Printer
Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has 
specified that the following notice be brought to the attention of the users of this 
product:

Note: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the product into an outlet on a circuit different from that to which the 
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this 
product not expressly approved by Eastman Kodak Company might cause 
harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency 
exposure limits. Nevertheless, the product shall be used in such a manner 
that the potential for human contact during normal operation is minimized. 
This product and any attached external antenna, if supported, shall be placed 
in such a manner to minimize the potential for human contact during normal 
operation. In order to avoid the possibility of exceeding the FCC exposure 
limits, human proximity shall not be less than 20 cm (8 inches) during normal 
operation.
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Canadian statements
This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Kodak declares that this wireless KODAK All-in-One Printer is in 
compliance with the essential requirements and other relevant provisions of 
Directive 1999/5/EC.

German compliance statement 

CAUTION:
This device is not intended for use in the direct field of view at visual display 
workplaces. To avoid incommoding reflections at visual display workplaces 
this device must not be placed in the direct field of view.

CAUTION:
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am 
Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am 
Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren 
Gesichtsfeld platziert verden.

Noise emissions for this equipment do not exceed 70 dBa.

This equipment is not intended for use in the workplace in accordance with 
BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß 
BildscharbV vorgesehen.” 
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KODAK ESP 1.2 All-in-One Printer
REACH Article 33 declarations
Go to www.kodak.com/go/REACH for information about the presence of 
substances included on the candidate list according to article 59(1) of Regulation 
(EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. 
Contact your local authorities or go to www.kodak.com/go/recycle for recycling 
program information.

ENERGY STAR® Qualified All-in-One Printer
To conserve energy, this printer will enter a reduced power (sleep) mode 
automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up 
to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an 
ENERGY STAR partner, Kodak has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency. For more information on the ENERGY STAR 
program, see www.energystar.gov. 
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Warranty Information

Limited Warranty
Kodak warrants Kodak consumer electronic products and accessories (“Products”), excluding batteries, to be free from 
malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original dated 
sales receipt. Proof of the date of purchase will be required with any request for warranty repair.

Limited Warranty Coverage

Warranty service is only available from within the country where the Products were originally purchased. You may be required 
to send Products, at your expense, to the authorized service facility for the country where the Products were purchased. Kodak 
will repair or replace Products if they fail to function properly during the warranty period, subject to any conditions and/or 
limitations stated herein. Warranty service will include all labor as well as any necessary adjustments and/or replacement 
parts. If Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the purchase price paid for the Product 
provided the Product has been returned to Kodak together with proof of the purchase price paid. Repair, replacement, or refund 
of the purchase price are the sole remedies under this warranty. If replacement parts are used in making repairs, those parts 
may be remanufactured or may contain remanufactured materials. If it is necessary to replace the entire Product, it may be 
replaced with a remanufactured Product. Remanufactured Products, parts and materials are warranted for the remaining 
warranty term of the original Product, or 90 days after the date of repair or replacement, whichever is longer.

Limitations

This warranty does not cover circumstances beyond Kodak’s control. This warranty does not apply when failure is due to 
shipping damage, accident, alteration, modification, unauthorized service, misuse, abuse, use with incompatible accessories or 
attachments (such as third party ink or ink tanks), failure to follow Kodak’s operation, maintenance or repacking instructions, 
failure to use items supplied by Kodak (such as adapters and cables), or claims made after the duration of this warranty. 
KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED 
WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. In the event that 
the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the 
purchase date or such longer period as required by law. The option of repair, replacement, or refund is Kodak’s only obligation. 
Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of 
this product regardless of the cause. Liability for any special consequential or incidental damages (including but not limited to 
loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services or 
claims of your customers for such damages resulting from the purchase, use or failure of the Product), regardless of cause, or 
for breach of any written or implied warranty is expressly disclaimed.

Your Rights

Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation 
or exclusion may not apply to you. Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, 
so the above limitation may not apply to you. This warranty gives you specific rights, and you may have other rights which vary 
from state to state or by jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada
In countries other than the United States and Canada, the terms and conditions of this warranty may be different. Unless a 
specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists 
beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.
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KODAK ESP 1.2 All-in-One Printer
Declaration of Conformity

See www.kodak.com/go/declarationofconformity. 
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Index

A
access door, location, 1
ANDROID OS Device, printing from, 40, 41

B
back button, 2
black-and-white

scanning, 58, 60
BLACKBERRY Device, printing from, 39
button sounds, setting, 5

C
cancel button, 2
card stock, sizes, 18
cleaning

document backing, 64—65
printer, 63
scanner glass, 64—65

color
scanning, 58, 60

computer requirements, 83
configuring printer settings, 5
connecting to a wireless network, 6—12

additional printer, 12
from USB, 13
printer on additional computers, 12

control panel
location, 1

copy document features, 79
copy photo features, 80
copying, 42—53

documents, 42—47
adjusting settings, 43—44
changing number of copies, 45
copy sizes, 79
darkening, 47
enlarging, 46
lightening, 47
reducing, 46
using default settings, 42

photos, 48—53
adjusting settings, 49—50
changing number of copies, 51
copy sizes, 80
enlarging, 52
previewing on LCD, 50
reducing, 52
using default settings, 48

setting options, 43—44, 49—50
country/region, setting, 5

D
darkening copies

documents, 47
photos, 53

date and time, setting, 5
declaration of conformity, 91
defaults

resetting, 5, 74
save copy settings as

documents, 44
photos, 50

save print settings as, 32
save scan settings as, 58, 60

document backing, cleaning, 64—65
document paper sizes, 81
documents

copying, 42—47
printing, 27—28
printing two-sided, 27—28

downloading (updating)
printer firmware, 73—74
software, 73—74

DPOF (digital print order format) printing
See tagged images, printing

duplexing, 27—28

E
Energy Star qualification, 89
energy-saving sleep mode, 5
enlarging copies

documents, 46
photos, 52

envelopes
capacity, 25, 80
loading, 25
sizes, 20, 81

envelopes, sizes, 18

F
finding photos, 31
firmware, downloading (updating), 73—74

G
glass, scanner

cleaning, 64—65
location, 1

Google Cloud Printing, 37
graph paper, printing, 28
grocery list, printing, 28

H
home button, 2
Home Center Software, 3, 29, 54, 61, 62, 74
hostname, printer, 11
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Index
I
image formats supported, 82
index card stock sizes, 81
ink cartridges, replacing, 66—68
ink levels, 74
IP address, 11

setting up, 10
iPad, printing from, 39
iPhone, printing from, 39
iPod touch device, printing from, 39
iron-on transfers, sizes, 18, 81

K
keyboard on LCD, using, 10
KODAK, 41
KODAK All-in-One Printer Software, 3
See also <DefaultParaFont>, 3
KODAK Document Print, 41
KODAK Document Print application, 41
KODAK Email Print Service

printing from, 38
KODAK Home Center Software

See Home Center Software
KODAK Pic Flick application, 41

L
label sizes, 81
labels, sizes, 18
language, setting, 5
LCD, 2
lightening copies

documents, 47
photos, 53

loading paper input tray
envelopes, 25
photo paper, 23

M
MAC address, viewing, 11
marked images, printing

See tagged images
media supported, 81
memory card slot, location, 1

N
narrow-ruled paper, printing, 28
navigation buttons, 2
network, wireless

See wireless network

O
ok button, 2

ordering supplies, 4
output tray extender, location, 1

P
paper, 18

loading input tray
envelopes, 25
photo paper, 23

sizes supported, 19, 81
types supported, 18, 81

paper guard, location, 1
paper input tray

capacity
envelopes, 25, 80
photo paper, 23, 80
plain paper, 80

location, 1
paper output tray, location, 1
paper-edge guides, location, 1
photo

printing, 29—34
features, 79

adding date to prints, 79
image enhancement, 79
print sizes, 79
scene balance, 79

See also printing pictures
photo paper

capacity, 23, 80
loading, 23
sizes supported, 82

photo paper, sizes, 18
plain paper

capacity, 80
sizes supported, 81

plain paper, sizes, 18
power button, location, 1
power cord connection port, location, 1
printer, 11

cleaning instructions, 63
defaults, resetting, 5, 74
hostname, 11
maintaining, 63—74
settings, configuring, 5
supplies

ordering, 4
recycling, 63

printer connection, changing USB to wireless, 13
printer name, 11
printhead

removing, 70
replacing, 69—72

printhead, location, 1
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Index
printing, 27—35, 37—38
documents, 27—28

two-sided, 27—28
forms, 28
from ANDROID OS Device, 40, 41
from BLACKBERRY Device, 39
from iPad, 39
from iPhone, 39
from iPod touch device, 39
from mobile devices, 37—38
graph paper, 28
grocery list, 28
narrow-ruled paper, 28
pictures, 29—34

from a memory card, 29—34
setting options, 31—32
tagged images, 5, 34
using default settings, 30

reminder list, 28
sheet music, 28
tic-tac-toe, 28
using Google Cloud Print, 37
using KODAK Email Print Service, 38
wide-ruled paper, 28

printing from a wireless device, 35

R
recycling printer or supplies, 63
reducing copies

documents, 46
photos, 52

regulatory compliance statement
Canadian, 88
European, 88
FCC, 87
German, 88
REACH Article 33 declarations, 89
WEEE, 89

reminder list, printing, 28
replacing

ink cartridges, 66—68
printhead, 69—72

resolution, scanning, 55, 56
rotate button, 2

S
safety information, 85—86
scanner glass

cleaning, 64—65
location, 1

scanner lid, location, 1
scanner type, 80
scanning, 54—62

automatically detect pictures, 56
features, 80
file format

document, 55
picture, 56

from computer, 61—62
from control panel, 57
maximum scan size, 80
multiple pictures simultaneously, 62
resolution, 55, 56
selecting quality, 56
setting options, 57—58, 59—60

Service Set Identifier, 7
settings

copying documents, 43—44
copying photos, 49—50
printing pictures, 31—32
scanning, 57—58, 59—60

sheet music, printing, 28
sleep mode, 5
software

downloading (updating), 73—74
support, 82

specifications, 79—82
SSID, 7
start button, 2
supplies

ordering, 4
recycling, 63

support see Web support
system requirements, 83

T
tagged images, printing, 34
tic-tac-toe, printing, 28
time and date, setting, 5
time to low power, setting, 5
transferring pictures to a computer, 35
tray, paper input, capacity

envelopes, 25, 80
tray, paper, capacity

photo paper, 23, 80
plain paper, 80

troubleshooting, 75—77
help on the web, 77

two-sided printing, 27—28

U
updating

firmware, 73—74
software, 73—74

USB connection, changing to wireless, 13
USB port, location, 1
94 www.kodak.com/go/aiosupport



Index
V
viewing, 11
viewing photos, 31

W
warranty

ink, 82
printer, 83
printhead, 83

Web support
downloads, 77
Electronics Industry Alliance, 63
Material Safety Data Sheets (MSDS), 86
networking, 75
REACH Article 33 declarations, 89
recycling, 63

WEP key, 8
wide-ruled paper, printing, 28
Wi-Fi connectivity LED, location, 1
Wi-Fi Setup wizard, 7
Wi-Fi technology supported, 82
wireless network

configuration, viewing and printing, 11
connecting to, 6—12

additional KODAK All-in-One Printer(s), 12
from USB, 13
non-WPS router, 7
printer on additional computers, 12
using Wi-Fi Setup wizard, 7
WPS router, 9

IP address, setting up, 10
settings, configuring, 6
subnet, viewing, 11

WPA/WPA2 passphrase, 8
WPS, 6
WPS router, 9

Z
KODAK All-in-One Printer Software

, 3
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